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C h a p t e r 5
 

Solid Part Four –  
A Bracket Made by 
Mirroring 
 

 
This chapter will cover the following to World Class standards: 

 
 Sketch of a Solid Problem 
 Draw a Series of Lines 
 Finish the 2D Sketch 
 Extrude a 2D Sketch 
 Add Multiple Fillets 
 Add Multiple Holes 
 Add a Slotted Hole 
 Add a Tapped Hole 
 Mirror the Solid 
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Sketch of Solid Part Four 
________________________________________________________ 
 
Again we start any project by making a sketch, so we can efficiently produce a drawing. In part 
4, we see a sketch of another bracket. The length of the bracket legs are 1 inch long. The 
thickness of the material is 0.125. There are four 0.125 rounds or fillets and four 0.201 diameter 
holes on the feet of the bracket. At the top of the bracket, we have a 0.5 by 1.0 slotted hole and 
two 6-32 UNC tapped holes. 
 

 
Figure 5.1 – Problem Four Sketch
 
In the fourth problem, we will practice techniques that we learned in the previous part sketches 
and add some new experiences such as slotted holes, tapped holes and mirrored solids. We will 
continue to add holes and fillets. We will still use multiple sketches and extrusion techniques to 
create the solid part. 
 
In this project, we will only draw half of the bracket and then when we are done with graphically 
describing all of the features, we will mirror the solid to make the entire bracket.  
 
 
 
 
 



5-3 

Starting a 3D Part Drawing Sketch 
________________________________________________________ 
 
When we open the AutoCAD Inventor application, we will select New from the menu. 
 

 
Figure 5.2 – AutoCAD Inventor Professional 2012 
 
A New File window will appear and there 
are four tabs on this dialogue box.  They are 
Default, English, Metric and Mold design. 
For this drawing, we will select the English 
tab and the Standard (in) ipt template. We 
will press the OK button to continue. 

  
 Figure 5.3 – Starting the drawing using the 

Standard IPT template 
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To turn off the grid if it is on the new drawing, we will go to the Tools tab on the Ribbon and 
choose Applications Options. 
 

 
 
Figure 5.4 – Starting the drawing using the Standard IPT template 
 
In the Applications Options dialogue 
box, we will turn off the Grid Lines.  
 
For this chapter, we picked the 
Colors tab on the Applications 
Options and we select 1 background 
color and Presentation for the Color 
Scheme list. Having the grid and 
color on the drawing sketch 
background has no effect on the 
drawing, but is the designer’s 
personal preference. 

  
 Figure 5.5 – Application Options Window 
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Drawing a Series of Lines 
________________________________________________________ 
 
The entity we will learn to draw in Inventor is a Line. We right click on the 
drawing and we can see Line in the center top of the menu.  

 
To draw a line, we right click on the drawing 
and we can see Line, Center Point Circle, Two 
Point Rectangle and many more choices. We 
pick Line and we will single click on the center 
portion of the graphical display and then we 
can pull the line in any direction. 

 Figure 5.6 – Graphical Display Menu
  
To draw a series of lines to create a profile, we 
begin by picking a point on the lower left 
portion of the graphical display and then we 
pull the line to the right. We keep the cursor 
directly to the right and the application will 
report 0.00 degrees in the horizontal. We will 
input 1.125 in the measurement textbox and 
press the Enter key. 

  
 Figure 5.7 – First Line Segment 
  

Next, we draw a line perpendicularly upward 
at 90 degrees. We will input 1.875 in the 
measurement textbox and press the Enter key. 

  
 Figure 5.8 – Second Line Segment 
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Then we draw a line perpendicularly to the 
right at 90 degrees. We will input 0.75 in the 
measurement textbox and press the Enter key. 

  
 Figure 5.9 – Third Line Segment 
  

We then draw a line perpendicularly upward at 
90 degrees. We will input 0.125 in the 
measurement textbox and press the Enter key. 

  
 Figure 5.10 – Fourth Line Segment
  

We then draw a line perpendicularly to the left 
at 90 degrees. We will input 0.75 in the 
measurement textbox and press the Enter key. 

  
 Figure 5.11 – Fifth Line Segment 
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We then draw a line perpendicularly 
downward at 90 degrees. We will input 1.875 
in the measurement textbox and press the Enter 
key. 

  
 Figure 5.12 – Close the Profile 
  

We then draw a line perpendicularly to the left 
at 90 degrees. We will input 1.0 in the 
measurement textbox and press the Enter key. 

  
 Figure 5.13 – Diagonal Line  
  

For the last segment, we will want to close the 
profile, so we right click on the graphical 
display and we select Close from the menu. 
The bracket will appear as shown in Figure 
5.14. 

  
 Figure 5.14 – Diagonal Line 
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Figure 5.15 – Profile with Dimension Showing
 
 
 
* World Class CAD Challenge 61-09 * - Close this drawing file.  Create a New file and 
draw the profile of eight lines. Complete the task in less than 5 minutes.  Continue this drill 
four times, each time completing the drawing under 5 minutes to maintain your World 
Class ranking.   
 
* World Class CAD Challenge * - Report your best times to World Class CAD at 
www.worldclasscad.com to obtain your world class ranking. 
 
 
 

Finish 2D Sketch of Solid Part One 
________________________________________________________ 
 
Before we extrude the sketch, we need to right click on the graphical display 
and on the menu; we choose the Finish 2D Sketch button.  
 

 
Figure 5.16– Finish 2D Sketch 
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Extruding a 2D Sketch 
________________________________________________________ 
 
Now that we have a finished sketch, we need to extrude the part. We can go ahead 
and pick the Extrude button on the Model tab of the Invertor ribbon. The Extrude 
window will appear on the display. 
  

On the Extrude window, we can either output a 
solid or surface. The differences between the 
two are that the first is like a hard piece of 
aluminum and the second choice is similar to a 
box. We will pick the Solid output on the left. 
Next, our part will be made from finished 
aluminum, so we will change the Extents 
distance from 1.0 to 1.5.  
 
We select the profile area and when it turns 
red, we click again to extrude the solid. 

  
 Figure 5.17 – The Extrude Window 
 
 
 

Drawing Multiple Fillets 
________________________________________________________ 
 
The next feature we will add to our bracket is the four fillets. We choose the 
Fillet button on the Inventor ribbon and the Fillet window will appear on the 
graphical display. 
 

We set the fillet radius to 0.125. When we 
select the straight edged corner, the pointed 
edge will change to a 0.125 inch rounded 
corner. 

  
 Figure 5.18 – First Fillet 
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We should select the other three straight edges 
and the pointed edges will change to a 0.5 inch 
rounded corners. 
 
To make the placements permanent, we press 
the OK button. 

  
 Figure 5.19 – Second Fillet 
  

After closing the Fillet window, we are ready 
to add the clearance holes in the base of the 
bracket. 
 

  
 Figure 5.20 – Finished Fillet 
  
  
  

Drawing Multiple Holes 
________________________________________________________ 
 
The next entity we will learn to draw in Inventor is a Hole. We choose the Hole 
button on the Inventor ribbon and the Hole window will appear on the graphical 
display. 
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We begin the process of adding a hole by 
making a new sketch. 

  
 Figure 5.21 – New Sketch 
  

We then choose the plane for the new sketch, 
so we pick the surface as shown in Figure 5.22. 

  
 Figure 5.22 – Select the Plane 
  

Now, we will select Point on the Sketch tab of 
the Inventor ribbon. 

  
 Figure 5.23 – Select Center Point 
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We place the cursor over the top yellow line of 
the plane to find the midpoint and we place a 
point towards the top of the plane and another 
directly below it. We will add dimensions to 
locate the centers precisely.  

  
 Figure 5.24 – Select the Two Centers 
  

We choose Dimension on the Inventor ribbon 
and we pick the top left corner of the plane and 
the center of the top center point. The 
dimension is 0.500. We again choose 
Dimension on the Inventor ribbon and we pick 
the top left corner of the plane on the center of 
the top center point. We will edit the 
dimension and input 0.25. 

  
 Figure 5.25 – Dimension the Top Center 
  

For the third time, we select Dimension on the 
Inventor ribbon and we pick the center of the 
top center point and the center of the bottom 
center point. We will edit the dimension and 
input 1.0. 

 

  
 Figure 5.26 – Dimension the Bottom Center 
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Before we extrude the sketch, we need to right 
click on the graphical display and on the menu; 
we choose the Finish 2D Sketch button. 

  
 Figure 5.27 – Finish the 2D Sketch 
  

We then select the Hole button on the Inventor 
ribbon and the Hole window will appear on the 
graphical display. We are making a 0.201 
through hole, so we change the diameter 
textbox from 0.25 to 0.201. The two hole 
placements appear automatically and we press 
the OK button to retain the feature. 

  
 Figure 5.28 – Add Holes to the Centers 

 
 
 

Drawing a Slotted Hole 
________________________________________________________ 
 

We begin the process of adding a hole by 
making a new sketch. 

  
 Figure 5.29 – Another New Sketch 
  

We then choose the plane for the new sketch, 
so we pick the surface as shown in Figure 5.30. 

 
  
 Figure 5.30 – Select the Plane 
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We want to draw a rectangle on the plane, so 
we right click on the drawing and we can see 
Create Line, Center Point Circle, Two Point 
Rectangle and many more choices. We pick 
Two Point Rectangle and we will single click 
on the yellow right edge of the plane and 
another point on the middle of the plane.  
 
This any sized rectangle on the plane has two 
dimensions. The horizontal measurement is 
highlighted and we can type 0.25. We press the 
tab on the keyboard to switch to the vertical 
dimension and we input 1.0. 
  
 Figure 5.31 – Add a Rectangle 
  

We choose Dimension on the Inventor ribbon 
and we pick the top right corner of the plane 
and the top right corner of the rectangle. The 
dimension is 0.25.  

  
 Figure 5.32 – Add a Dimension  
  

Before we extrude the sketch, we need to right 
click on the graphical display and on the menu; 
we choose the Finish 2D Sketch button. 

  
 Figure 5.33 – Finish the 2D Sketch  
  

Now that we have a finished sketch, we need 
to extrude the slot. We can go ahead and pick 
the Extrude button on the Model tab of the 
Invertor ribbon. The Extrude window will 
appear on the display. Then we will click on 
the slot and it will become highlighted in red.  

 
  
 Figure 5.34 – Select the Extrusion Area  
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Click on the direction icon so that the new 
solid goes down into the bracket. Click on the 
red area again and a rectangular slot will 
appear in the top of the bracket.  

  
 Figure 5.35 – Extrude the Slot  
  

The next feature we will add to our slot is two 
fillets. We choose the Fillet button on the 
Inventor ribbon and the Fillet window will 
appear on the graphical display. 
 
We set the fillet radius to 0.25. When we select 
the straight edged corner inside the rectangular 
slot, the pointed edge will change to a 0.25 
inch rounded corner. 
  
 Figure 5.36 – Add Two Fillets  
 
 
 

Drawing a Tapped Hole 
________________________________________________________ 
 

We begin the process of adding a hole by 
making a new sketch. 

  
 Figure 5.37 – Start a New 2D Sketch  
  

We then choose the plane for the new sketch, 
so we pick the surface as shown in Figure 5.38. 

 
  
 Figure 5.38 – Select the Plane  
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Now, we will select Point on the Sketch tab of 
the Inventor ribbon. Then we place the cursor 
over the left yellow line of the plane to find the 
midpoint and we place a point towards the 
middle of the plane. We will add dimensions to 
locate the centers precisely. 

  
 Figure 5.39– Add a Center Point  
  

We choose Dimension on the Inventor ribbon 
and we pick the top right corner of the plane 
and the center of the center point. The 
dimension is 0.4375, so we will edit the 
dimension and input 0.4375. 

  
 Figure 5.40 – Dimension the Center Point  
  

Before we extrude the sketch, we need to right 
click on the graphical display and on the menu; 
we choose the Finish 2D Sketch button. 

  
 Figure 5.41 – Finish the 2D Sketch 
  

We then select the Hole button on the Inventor 
ribbon and the Hole window will appear on the 
graphical display. We are making a 6-32 
tapped hole, so we choose the tapped hole 
icon. We pick ANSI Unified Screw Threads, 
0.138 (#6) for the size, 2B for the class and 6-
32 UNC for the designation. The hole that 
automatically appeared will appear tapped and 
we press the OK button to retain the feature.  

  
 Figure 5.42 – Add a Tapped Hole 
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Mirror a Solid 
________________________________________________________ 
 
The next function we will learn to draw in Inventor is mirror. We choose the 
Mirror button on the Inventor ribbon and the Mirror window will appear on 
the graphical display. 

 

 

We select the Solid icon and then the Mirror 
Plane icon. We pick the plane as shown in 
figure 5.43. 

  
 Figure 5.43 – Select the Mirror Plane 
  

The other half of the solid will appear as a 
wireframe. We press the OK button to make 
the complete bracket. 
 
We can change the view to see the hidden 
lines, so we go to View on the Inventor ribbon 
and we choose Visual Style and pick Shaded 
with Hidden Edges. The drawing appears as 
shown in figure  
 

  
 Figure 5.44 – The Mirrored Solid 

  

 
Figure 5.45 – The Finished Solid 
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Save the solid bracket and we will make a new one in the next chapter. 
 
* World Class CAD Challenge 61-10 * - Close this drawing file.  Create a New file and 
draw the profile of eight lines. Add two holes on the bottom plane. Add a slotted hole and a 
tapped hole on the top plane. Mirror the solid. Complete the task in less than 10 minutes.  
Continue this drill four times, each time completing the drawing under 10 minutes to 
maintain your World Class ranking.   
 
* World Class CAD Challenge * - Report your best times to World Class CAD at 
www.worldclasscad.com to obtain your world class ranking. 

 


